G4 LD Utility Release History

©LARSON DAVIS
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List of changes made to Larson Davis G4 LD Utility software?!

G4 LD Utility Version 5.0.0 April 2024
New

1. 1.Added 377A12 %4” Microphone — supported in all 721 and 821 meters as of firmware 1.200.
Improved

1. Linear and OBA Time History Graphs for 721, 821, and 831 files — Interactions between the

Fixed

Linear and OBA graphs have been improved. The legend values now update for all graphs and
OBA spectrographs all highlight the same frequency as applicable. A frequency can be selected
by clicking on either the spectrograph or the overall OBA bar chart to lock it in so movement on
the X-Axis (time) will show values for the selected frequency at that time.

Linear Graph now shows the interval’s level for each metric as a stepped line — As sub-interval
values are not available and cannot be implied the level is shown as the same for the entire
interval instead of interpolating between two points with a slope. This also aligns each step with
the OBA Spectrographs.

HVM200 Format and Restore command is now sent correctly — This will reset the setups,
sensor list, Wi-Fi configuration, CalCheck histories, and remove all data files. Previously, both
Format and Format Restore would send only a Format command. See the HYM200 Release
Notes for more details.

HVM200 Data File’s modified overall data section MTVV or Amax values — The time history
values used to recalculate the MTVV or Amax were incorrect in the file prior to HYM200 version
5.0.0, G4 now shows a note in place of incorrect values when using edit bands for files made
with older firmware and shows the correct values for files made after being upgraded to version
5.0.0.

Agency Approval summary for SoundAdvisor 831C — All files with a broken agency approval seal
would always report non-approved firmware version as cause even with approved firmware
versions.

Data File List from SoundAdvisor 831C would not refresh automatically — This affected 831C
meters with version 4.1 through 4.6.2. The issue was introduced in G4 version 4.7 and is
resolved in version 5.0.0.

AudCal RETSPLs were not always being applied — The meter would sometimes miss the
notification to load new RETSPLs when the user would move to the next transducer type, side,
or test during a test run.

HVM200 OBA displayed units correction — OBA data for the HYM200 are not integrated but the
displayed units applied integration incorrectly. (e.g. input units set to ‘m/s? with double

1 Note: Numbers in parenthesis such as “(3210)” are an internal tracking number. Test Track Items will be prefaced with TT.
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integration will show units of ‘m’ on the linear data and now show ‘m/s¥ on OBA data instead of
the errant ‘m’ on OBA data)

Push to Cloud Authorization Expiration — When authorizing a meter to push to Dropbox, the
meter was not being properly configured by G4 between 4.9.2 and 4.9.6, this prevented the
meter from pushing for more than four hours after each authorization requiring the user to
reauthorize repeatedly. To correct the configuration issue on the meter repeat the steps to
authorize the meter using G4 version 5.0.0 or later.

Graph Selection Summary — With the feature to highlight a section of a time history graph to
view a summary (star icon), when selecting an area that includes a period with no data (paused
or stopped), the results reported were incorrect. Selecting areas with no data now shows
correct results.

Deprecated

11.
12.

Discontinuing 32-bit versions of G4 — 32-bit builds of G4 will no longer be made available.
Discontinuing Windows 7 Support for G4 — Running G4 on Windows 7 is no longer supported.

G4 LD Utility Version 4.9.6 January 2024
Fixed/Improved

1.

When uploading default settings from G4 into a legacy LxT meter, the incorrect nominal
microphone sensitivity was set — The nominal sensitivity is only used to validate that a
calibration level is in the expected range, so this would cause the meter calibration to display a
warning that it was out of normal range. This does not affect measurement data. The correct
nominal values will now be set when uploading a system properties file from G4 using the latest
version. The “Restore Defaults” functionality on the meter was not affected by this issue and
continues to work correctly.

G4 would display Spectral Ln data incorrectly from 831C meters with firmware version 4.9.5 —
Files will display correctly if opened in G4 version 4.9.6.

G4 would sometimes not detect 730, 721, and 821 devices over BLE due to incorrect
initialization — The detection and communication for BLE is correctly being initialized in G4 4.9.6.
BLE communication was unstable for some devices — When G4 would detect 721/821 devices it
would begin requesting data prematurely from all 721/821 devices. This could lead to BLE
communication stopping. G4 version 4.9.6 uses correct timing and conditions to communicate
with the device.

Background services would not auto download data files from 730, 721, and 821 devices — The
services failed to respond to file list changes. In G4 4.9.6 the services will now respond by
getting the file list and downloading new files.

G4 LD Utility Version 4.9.5 December 2023
Fixed/Improved

1.

G4 would fail to update 831C firmware from versions older than 4.0.0 — Introduced in G4 4.9.0,
if an 831C had firmware older than 4.0.0 G4 would fail to update it.
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2. G4 would prematurely round Measurement History data for 730, 721, and 821 — The value was
rounded to 1 or 2 decimal places which could introduce error if used for other calculations.

3. G4 fails to get afile list or download from meters with a space at the beginning or end of their
nickname or containing project name in the G4 Device Panel — This prevents listing and
downloading files from these meters including automatic downloading of files. This is the local
name a user can assign to their connection to the meter within the G4 Device Panel and not the
meter’s Device Name. G4 now removes these spaces from existing meters and projects when
installing the new update and removes them when setting the new meter nickname or project
name.

4. Issue viewing files with the same tab label as other files — Previously, if multiple files were
opened that had the same text in the tab label, only the left most tab could be selected to view.
Additionally, attempting to close one such file would close an additional file with the same tab
header as well. The tab header is dependent on the type of file being opened but 730, 721, and
821 share a file type and 831C and Legacy SLMs share a file type. The file name is When closing
any files that had the same label as another open file, G4 would close two matching files at a
time. The work around was to only have one file from each start time open at once.

5. Issue opening multiple files at once — Opening several files at once regardless of file type, either
by selecting multiple files in the Open File Dialog from the “Open Data File” menu item or by
checking multiple files that are already downloaded in the meter file list and clicking the “Open”
button above the file list, had a low probability that some files fail to open. e.g., when opening
15 files at once, less than 15 file tabs appear. They will now all open. To avoid this in previous
versions only initiate one file open at a time.

6. G4 allowed invalid characters in the Marker settings fields for 721, and 821 — Some characters
would be removed from the settings when saving, others were not removed and would result in
files that G4 could not parse. When a character was removed it would show a warning that the
setting had been changed when it was saved. Now a tooltip is displayed when hovering over the
Markers input fields explaining the input restrictions (i.e. "Use up to 16 characters from the
following set: lowercase letters (a-z), uppercase letters (A-Z), numbers (0-9), and the #
symbol."). The invalid characters and any character after the length limit are ignored during
input. In previous version of G4 the same restrictions were present but only partially enforced
during saving not during input entry. When using older versions please adhere to these
restrictions.

7. G4 would fail to set the clock on 730, 721, 821 if Auto-Store was disabled — This would occur if
the meter had collected the data for a measurement but had not stored the measurement to a
file. G4 now presents a warning dialog indicating the issue and providing appropriate actions.
Having Auto-Store enabled or ensuring that the file was stored before attempting to set the
clock would prevent this issue.

8. AudCal Broadband Noise Test not starting in G4 - Three frequencies were tested for flatness
and magnitude as part of verifying the test pre-condition but no message was shown explaining
when the conditions were not met. Now a message will be displayed informing the user that the
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conditions are not met (i.e. "Not detecting an input signal with 1000 Hz above 50 dB HL") either
before the test starts or if the signal drops below the specified level during the test.

9. AudCal Broadband Noise Test not preserving test result in G4 — Switching to another test and
then back to Broadband Noise would lose the test data from the previous Broadband Noise test
run. This is now fixed to allow viewing other results without losing the data from the Broadband
Noise test.

10. Improved error message when file download fails — G4 will display a message box when an
error occurs involving an ongoing file download from a meter. Previously the download would
error out without warning.

11. Corrected displayed values and units in FFT files using non-microphone transducers (e.g.
Accelerometer) — The y-axis units selection drop down in the graph view showed base units
without integration applied. Now it shows them correctly. The Harmonic Distortion section
showed values in the transducer’s units but labeled them with the Display Units, they are now
converted to the display units and labeled correctly. G4 showed the RMS value with units
matching integration when the value is not integrated, the value is no longer displayed when
integration is enabled.

12. Displayed Metric was mislabeled in the file list — The metric displayed in a meter’s file list for
downloaded files would show the value for Leq but label it incorrectly if it had been set to Lpeak
prior to the labels being standardized to Lpk. Now, any metric that had previously been set to
Lpeak will be changed Lpk. This could be corrected manually by going to “Tools->Options-
>Displayed Metrics” and correcting any blank drop-down selectors.

G4 LD Utility Version 4.9.4 November 2023

Fixed
1. Fixed issue that prevented installation on 32-bit systems that was introduced in 4.9.2.

G4 LD Utility Version 4.9.3 November 2023
Fixed
1. Fixed issue that prevented 831C, HVYM200, and Legacy SLM drivers from installing on newer
versions of Windows 10 and Windows 11. The driver will now install on Windows 10 and
Windows 11 system.

G4 LD Utility Version 4.9.2 October 2023
Fixed
1. Fixed issue introduced in 4.9.0 that prevented 831C, HVYM200, and legacy SLM drivers from
installing.

2. When opening an LD7 file from a 721/821, the spreadsheet for 721/821 files always showed the
slow detector spectra for the Overall OBA but labeled it with the detector specified by the
meter’s settings. The correct spectra will now be displayed and labeled correctly for any data file
opened with G4 4.9.2 and later.
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3. LD7 files generated by the 730 and 730IS with firmware older than 1.118 had the TWA3 and
TWADS values swapped in the time history data. G4 now accounts for this when opening files
created by 730 FW older than 1.118 and displays them in the correct columns. It will also correct
any modified data including Dose, Projected Dose, Lavg, TWA(8), and Projected TWA(8) data
that were calculated using the incorrect columns. To correct any results that were previously
exported to other file types, they will need to be re-exported.

4. A bug that prevented opening a Bluetooth connection to a 730, 721 or 821 after it was
calibrated has been fixed. This bug would cause the meter to appear inactive (grey text) in the
device list. G4 would erroneously connect and communicate over BLE to 730/721/821 meters
that were visible in the meter panel when they finished a Calibration. This prevented the meter
from advertising to other computers or devices and could make the meter appear unavailable
from the device list.

5. Marine Mammals Protection files created without Event History can now be accessed in G4. An
upgrade to version 4.9.2 resolves the issue that prevented these files from opening in version
4.9.0.

6. When exporting settings files the default path was incorrect and caused the export to fail. The
default path now works.

G4 LD Utility Version 4.9.1 June 2023
1. Updated firmware for Spartan 730, Spartan 821/721, and SoundExpert 821/721 meters.
G4 LD Utility Version 4.9.0 June 2023
Added

1. G4 supports the new Spartan 821/721 and SoundExpert 821/721 meters.
Improved

2. The linear graphs in the file view will display data that exceeds the extremes of the y-axis. Single
points will be marked to help visualize the data.

3. Forthe Spartan 730, notes entered in files show in the Notes field in the report and in the
summary data tab, while notes entered during a measurement will be captured as markers.

4. Renamed “Comments” column in Measurement History, Event History and Time History tabs to
“Markers”.

5. OBA spectrogram left align with the associated linear data points and take into account the size
of partial data records when the time history period is greater than one second.

6. Updated G4 to include latest security updates for browsing meters.

7. Labels for peak are now pk.

8. Improved settings conflicts for RT60 measurements.

9. Added Reset state in the meter panel for 831C.

10. Eliminated need for administrator privileges to disable and enable the automated download and
connection services from G4 Options.

11. File search now includes models (e.g. 831C, LxT, 730, etc.) and serial numbers.
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12. The graphs show values that extend beyond the extremes of the y-axis. The single data points
on the graph also do not completely disappear if not connected to other points in the visible
portion.

13. Forces y-axis max and min values to be different on graphs and auto-corrects if identical values
are entered.

14. You may move the Edit Band popup, enabling you to see and inspect the graph while configuring
the edit band.

15. AudCal: The New Zealand standard prints on the associated booth test.

16. Enabled ability to change the time fields on 831A without having to enable Host Port or GPS.

Fixed

17. General Info would not persist in the spreadsheet when navigating to the report.

18. Cancelling the Marine Mammal popup would inhibit future processing using this feature.

19. Data spreadsheet did not allow navigation using arrow keys. For example, pressing the down
arrow to navigate to the next cell in a column or Ctrl-d to jump to next non-empty cell in the
column.

20. AudCal: Generating booth test certificates, only the first one would work, where subsequent
tries would fail.

21. AudCal: Extra Audiometers would show up in the generated “Audiometers Due for Calibration”
report. The report would not generate unless you enabled the automatic notification option.

22. AudCal: Linearity would not store test data performed for frequencies other than 1 kHz. Now,
the report will show the last tested frequency.

23. AudCal: The speech RETSPL was set at supra aural level regardless of the specified transducer. It
now follows the correct level for the chosen transducer.

24. AudCal: The Hearing Level test displayed results on the report with an extra column that G4 did
not labelled, shifting the data to the right and truncating the last column.

25. Markers added to Measurement History and Event History tabs now get stored when saving the
data spreadsheet.

G4 LD Utility Version 4.8.3 March 2023
Fixed
1. Fixed issue where G4 would not download updated firmware packages when they became
available on the web.
2. Fixed issue where G4 would not display the correct LCeq value when the meter triggers a
calibration on the 730.

G4 LD Utility Version 4.8.2 February 2023

Fixed
1. 831C AudcCal: Reports work correctly when language is set to French. Added New Zealand
standard to Booth report.
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Fixed issue that would cause USB communication with 831C, 831, or LxT to not work when G4 is
installed for the first time.
When “Allow Auto-Download from available configured meters even when G4 is not running” is
checked, files would only download when G4 was open and not when it was closed.
Auto Download service would crash when firmware on 730 meters were being updated.
Criteria for accepting calibration results on the 730 has been tightened to improve overall
calibration accuracy. Requires 730 FW version 1.114 or later.

G4 LD Utility Version 4.8.1 December 2022

Added
1.

We updated Audiometer Calibration to use the ANSI S3.6 (2018) and ANSI S3.6 (1989)
standards. This requires a change to the settings for tests with speaker transducers when using
2010-2017 standards, in which the Binaural selection provides a Diffuse setting. The tests using
standards 2010-2017 show Left/Right sides (Diffuse) for previously executed tests and only the
Binaural selection for tests from now on with the checkbox for diffuse. Tests using the standards
from 1989 to 2004 continue to show the Left/Right sides (Monaural) for speaker transducers.
For the 2018 standard, the tests for speaker transducers display only Binaural with additional
angles (from the standard) and the diffuse checkbox.

Data View Mode

Fundamental: --- Hz
THD: -—-%
Incidence O Qe . 450 .

AudCal support for booth testing in compliance with New Zealand document, "Assessment of

occupational noise-induced hearing loss for ACC", page 25.

We added an entry for standard "NZ ONIHL-ACC" to the standards drop-down box. This
selection will show MPANL options for "Air", "Bone" and "Custom" (defaults to the same limits
as "Bone"). G4 will show only the seven frequencies defined by this standard for these test runs.
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3. You may now setup a time sync between your PC and your meters. In the Tools > Options, you
can choose to enable the Time Sync to the meter at a given time of day. If using services, they

will perform the sync in the ~AudCol Options. |/ Command Line Settings. | Sec RS b
background. Otherwise, you
will need to keep G4 running to ARG

perform the auto time sync. On @ Daily Sync Time (Hour:Minute) [ 121 15

a Model 831, ensure that the @ Sync Meter Clock to PC Clock
Time Zone Offset is correctly e

ragement

setup in Preferences. @ Sync User Field to Meter's Nickname

This new time sync option enable three different options for sync’ing time-

a. Option 1 =NTP (most accurate): Only available on the 831C and requires GPS and/or
internet connection. If NTP is set on the meter, then G4 will not time sync. This is the
recommended method for the 831C.

b. Option 2 =Sync on Open: Available for all meters and happens at time of opening the
meter. G4 will ask to sync time and user can select yes/no except for Spartans where
time sync's occur automatically when time is greater than 4 seconds.

c. New in G4 V4.8, Option 3 = Sync on schedule: the Time Sync works for all meters except
where the 831C using NTP automatically disables it. We designed this option for 831
meters continuously connected by 831-INT-ET. If G4 does not connect to the meter at
the time of the scheduled sync, then the service will sync time on the next scheduled
sync. Typical accuracy is +/- 2 seconds.

4. After changing the meter's name in the Meter Panel, you can instruct G4 Services to push the
name to the meter's chosen System Property device field. If you do not have services
configured, then the update occurs only while G4 is open.

5. G4 automatically updates documentation and firmware packages, configurable from the Tools >

Options.
" Auto Update Settings
& Automatically check for updated documentation
¥ Automatically check for updated meter firmware % Keep Old Versions
Check For Updates Now
Improved

6. Downloads are more robust with communication validation improved. Each meter allows one
download at a time.

7. 831, 831C, 730: G4 sound record processing has been improved to generate consistent sound
record file names when exported via command-line processing, automatic downloads, or saving
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10.

11.

12.

13.
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from the Audio Player. The sound records are placed in a sub-folder next to the input .Idbin file.
The sub-folder has the same name as the input file with "_SR" appended to the end.

831_0002828-20221020 134437-22102001.LDO_SR
€ 831_0002828-20221020 134437-22102001.LD0.Idbin

Inside the sub-folder, each sound record is named as follows:
831, 831C
inputFileName_timeStamp_recordType sessionLogAudiolndex.wav (or .0gg)

Following is an example of sound record file naming:

£, 831.0002828-20221025 123151-22102500.LD0_12.30.51_voice-1.wav
£, 831_.0002828-20221025 123151-22102500.LD0_12.31.02_voice-2.wav
£, 831_.0002828-20221025 123151-22102500.LD0_12.31.51_measurement-1.wav
4, 831_0002828-20221025 123151-22102500.LD0_12.31.53_event-2Zwav
£/ 831_0002828-20221025 123151-22102500.LD0_12.32.07_event-3.wav
4,/ 831_0002828-20221025 123151-22102500.LD0_12.32.22_measurement-4.wav
4, 831.0002828-20221025 123151-22102500.LD0_12.32.32_event-5.wav
£, 831_0002828-20221025 123151-22102500.LD0_12.33.07_event-6.wav
¢4, 831_0002828-20221025 123151-22102500.LD0_12.33.21_voice-3.wav

730
inputFileName_timeStamp_recordType sessionLogAudiolndex.wav

Following is an example of sound record file naming:

) 730 1008-22102402-123210_12.32.23_SOUND.1.wav
4 730 1008-22102402-123210_12.32.46_SOUND.2.wav
£ 730 1008-22102402-123210_12.33.16_SOUMD.3.wav

Fixed issue where one meter type would show incorrectly (e.g., 730 looked like 831C). Updated
communication ports in Tools > Options to display an accurate port.

730: Correctly reads the "Custom" settings when switching to Custom in the virtual dosimeter
settings.

Issue where the Live View would not display correctly for all meters when the G4 language is set
to PC and the PC region/language is not one of the supported languages.

Auto downloads might stop before completion when the meter has more than 50 files to
download.

With continuous sound recording, audio playback on graphs sometimes skips to the last sound
record after playing any other record. When playing compressed audio files, you can now start
playback at any point.

Updated graph data to use proper English units.

14. When opening an SLM file with Time History and OBA data only, G4 might not load the graph.
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After installing G4, meters would not connect over USB.
When both measurement and event sound recording is enabled, the event sound record
numbers and associated playback on the Event History data tab did not match the correct sound
recording from the Session Log. Exported records still match the correct event. Opening Idbin
files will be corrected with this version of G4. Previously exported JSON and spreadsheet files
(.xIsx) will need to be re-exported to fix the numbering.
After creating an edit band that modified a 730 file, several fields displayed a time stamp when
none should exist in the modified data on the Overall tab.

Known Issues

18.

19.

20.

When the meter has over 1000 files, the 831C's performance is adversely affected and can cause
an unexpected meter reboot. To prevent this, keep the number of files less than 1000. You can
do this using the automatic delete feature in the 831C.

Model 831A, if sound records for both measurements and events are on, the measurement
sound recording will override the event sound recording if they overlap. You may decide to
disable the measurement sound recording to keep all the event sound records.

In G4 when a download starts, if another user or service was in the process of downloading, the
meter will stop the first download, allowing for the new request to begin.

G4 LD Utility Version 4.7.1 May 2022
Fixed
1. 831C: Certain strings in Italian caused the Ul to lock up in G4 Live View, Setup Manager and

certain graphs.

G4 LD Utility Version 4.7.0 April 2022
Added
1. RT60 measurements are supported on the 831C. RT60 measurements taken with the 831 or

831C can be viewed graphically with Position Ensembles and the ability to exclude and include
individual decays. Note: to view graphs or the new features with the data from an 831, Save All
Time Series must be selected in your setup before taking data.

Measurement Description for the LxT, 831 and 831C meters included in the search index. When
you download or open a file it is indexed. Old files that were downloaded prior to installing G4
version 4.7.0 will not be indexed except when navigating to Tools > Options > Displayed Metric
and clicking on Force Refresh of Old Files.

A preset dosimeter configuration called Canada has been added to support the new worker
exposure PEL of 85 dB Leg.

In the file Time History graph, you can select the star to enable selection of a period of time and
see summary information such as Leq for the selected time. A checkbox in the resulting popup
allows users to choose between viewing summary results for visible data or all available data.
831C: The meter live view displays the file name of the active settings and marks the name with
an asterisk after active settings are modified.
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Improved

6. Updated the live FFT full screen graph to use more of the available space in the view.

7. 831C AudcCal: Allow modification of the default test frequencies for audiometers. Modified
defaults are stored and used for all subsequently created audiometers.

8. Spartan 730 & 730IS: Shift Time setting added to all dosimeter configurations, including OSHA-
HC and OSHA-PEL and also added to reports.

9. 831C: Format and Restore is only allowed when connected by USB. This is to protect remote
installations from losing connectivity due to a remotely initiated Format/Restore defaults.
(12008, TT7369)

10. 831C: Allow meters to have the same hostname/IP address as long as they are configured to use
different ports. (12587)

11. 831C: In the G4 Live View, when viewing the Live data from an 831C, the meter displays the
most recent one second Leq and Lpeak levels. Data labels have been updated to show the 1 second
time period.

12. 831C: When connected to a meter using a network connection, users are required to have
Administrator rights in order to Format. You must be connected via USB to perform a Format
and Restore.

13. 730: The auto calibration has been improved so the meter will reliably enter calibration when a
calibrator is connected and the meter is stopped.

Fixed

14. 730: Updated the OSHA-HC Criterion Level (set to 90 dB from 85 dB) and Action Limit in Alarms
(set to 50% from 75%) to match the standards. G4 will automatically update and correct any
measurement file that used the previous settings when that file is opened.

15. 730: Data files with more than one million time history records now opens. Previously the initial
one million records were on the first time history sheet and subsequent data sheets duplicated
the first. Note: The graph will only show the first million records.

16. 831C: The Event Triggers for SPL1 and PK1 levels no longer get set to 0 dB when transferring a
default file from PC to the meter and set to active. (12198)

17. 831C: The command line export of a data file to XML or JSON failing when the file contained a
sound record is fixed. (12412)

18. When searching in the File View with zero results, the list will no longer jump to the end of the
list.

19. HVYM200: When upgrading firmware over WiFi the upgrade would fail without warning. Meters
with firmware prior to this version should use a USB connection to upgrade. Upgrades after this
version will succeed.

20. 831C: Email will no longer queue if hostname is blank.

21. 730: The Virtual Dosimeter 1 could be turned off resulting in the data not being visible with no

way to re-enable virtual dosimeter 1. By design virtual dosimeter should always be enabled and
G4 now ensures this..
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22. 730: If more than one timer was enabled, daily timer merge was on, and you ran and stopped
manually prior to the first timer block, then the time history for that run would not store in the
file.

23. Command line naming options set in Tools > Options > Command Line Setting were not being
used correctly when using the command line to process files giving different names than
expected.

24. When creating a report or certificate the name of the file was not displayed in the subsequent
popup.

25. On the 831C UI, the Time History "OBA by Time" page did not display the data. (12050)

26. 831C: AudCal no longer enforces a limit at 8 kHz for bone vibrator Hearing Level test. Note that
the standard has no specified RETFL for this frequency. (12018)

27. 831C, 831 & LxT: In a file time history graph and you have changed the y-axis extremes, the y-
axis extremes would reset after zooming in the x-axis and resetting the zoom.

28. 831C Settings: The range in dB presented with selecting the Normal or High range for OBA and
sound recordings could be incorrect when +20dB Gain is checked and unchecked.

29. Folder selection (including Import from USB or Save All Audio Files) would crash G4 if Federal
Information Processing Standard (FIPS) is enabled on the computer. (12554)

30. 831C: Dropbox authorization updated to work with File Push feature.

31. 831C: In FFT mode, the full screen graph would not update with harmonics enabled.

32. 831C: Audio Streaming from an 831C would not work sometimes.

33. 831C: Dropbox discontinued long term authentication tokens. With this release we have
implemented a new method of security authentication that allows the meter to continue to
push.

34. AudCal database sync with meter would produce an incompatible version message and would
not sync.

Known Issues
35. When downgrading the 831C, the meter may lose settings if the settings are new to the
firmware.
36. If you have data on the meter not stored when you upgrade firmware the meter may not
recover the data after the upgrade. Be sure to store data before you upgrade.

G4 LD Utility Version 4.6.6 January 2022

Added
1. Added support for the AMC493C mastoid.

Improved
2. A pencil icon now denotes the comments in the graph, and no longer moves off the graph when
adjusting the y-axis extremes.
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Fixed

3. During installation some files were installed with permissions that don't allow access from users
without Administrator rights. This results in G4 not being able to connect to meters or list files.

4. The connections to Spartan 730 meters over BLE would drop because G4 tried to open too many
connections simultaneously.

5. The Spartan upgrade process could have failed if the meter had old BLE firmware. G4 now also
provides more details in response to upgrade process. (TT7219)

6. Inthe HVYMZ200 File View, you can see and download .raw files.

7. The 831C Firmware upgrade process has improved communication that is now more error
tolerant.

8. AudCal: Fixed issue with the environmental adjustments for the AMC493 mastoid where the
adjustments were being subtracted instead of added.

9. When using commas for the decimal separator, the Spartan 730 file in G4 would display the
LAeq, LCeq and LZeq incorrectly by a factor of 10.

10. Adding projects directly to the "Projects" group will no longer insert them into a random project.
Some old projects had invalid settings that caused the problem and these now have proper
settings. You can find the misplaced projects previously inside these corrected projects directly
under the main "Projects" collection. You may decide to move them back inside a parent if
desired after updating G4.

11. SPL 1 and Peak 1 did not update the Event Trigger Levels when making changes on the
Exceedance Triggers page. The fix also affected the transfer from PC to the meter in Setup
Manager. The SPL 1 and Peak 1 values no longer transfer as zero.

12. If the user selected cancel during a firmware upgrade, the Spartan 730 would go offline for
several seconds.

13. G4 correctly handles mapped network drives that uses drive letters.

14. G4 would not start a second instance if services were turned on but not running.

15. When opening an SLM file, G4 would display a graph for an instant and then disappear, or would
show extra lines returning to the first of the graph.

G4 LD Utility Version 4.6.5 November 2021
Features

1. The Time History graph for SLM files now includes non-acoustic metrics such as weather or
voltage. Time stamp at cursor location added to the values legend.

2. Spartan and SLM files: Comments can be added to the Graph and SLM data views for
Measurement History, Event History, and Time History. Comments entered into either the
Graph or the Time History Data View will show up in both places.

3. You can specify from a list of metrics (Tools>Options>Displayed Metric) which one you wish to
display in the File View column titled Metric.

4. Added computation of metrics for marine mammal protection, which can be enabled in Tools >

Options > Misc.
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Added the Audio Calibration Constant to the 831C's Data Summary tab, which can be used to
convert the meter's recorded audio files.
Addition of the LAleq Live and Overall values to the Live View for Spartan 730 and 730IS meters.
By default, using G4 to delete files from the PC now moves those files to the recycle bin rather
than permanently deleting them. You may override this in Tools > Options > File or on a case by
case basis.
Calibration and Audio Streaming tabs have moved to the top navigation from the meter
Manager tab. You can Audio Stream from the same meter to multiple instances of G4 on
different PCs.
Part of G4 has been moved from the G4 application to software that always runs in the
background on a PC. In Windows terminology this is called a Service. These new services called
LDConnectionService and LDAutomationService monitor available connections and auto
download files in the background even when G4 is not running. This allows files to automatically
download from available meters without requiring a user to be logged in. These services also
speed up launching of G4. If this functionality is not wanted, the services can be disabled by an
administrator and G4 will only monitor connections and auto-download when it is running.
HVM200: Added microns (u) as selectable units. p/s? can have the integration applied to
become velocity or displacement. Added Crest Factor to the Summary page.

Improved

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

To speed up the process of opening files from the File tab, G4 no longer exports the data to .xlsx,
.json, or .csv files. Export occurs when a files is downloaded or opened and imported from an
SLM Archives. This Change prevents G4 from creating the same export multiple times and
potentially overwriting changes in an exported file. The command line interface can be also be
used to create export files.

SLM and HVM200: The Files view has been improved to reduce the refresh time when you have
several files downloaded.

The file list for 831C and Spartan instruments now displays measurement units in the metric
column.

Command Line file processing handles trailing backslashes in file paths.

Updated the axis for FFT graphs to display the numerical and logarithmic values.

The Setup File Import has improved messaging and buttons to help make decisions easier
(10743).

Setup Manager now refreshes the list of setups after doing an Import Settings or Extract From
File (10806).

Logos and signatures are saved with higher resolution to improve the quality of reports. It may
be necessary to re-import logos and or signature files to get the improved resolution.

AudCal: Updated the signature pad to provide better feedback and the buttons to help choose
the signature to use.

When displaying a graph on a report, the graph legend only shows items that are active on the
graph at the time the report was created.
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21

22

23

Fixed
24

25.

26.

27.

28.

29.
30.

31.

32.

33.

34.
35.

36.

37.
38.

39.

40.

41.
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SLM files: Added Instrument Identification fields to spreadsheet on the Summary tab, in the
Overall Settings section. This information is setup in the meter System Properties.
The G4 Options dialog accessed using Tools > Options now stacks tabs rather than scrolling to
allow better visibility of all tabs.
HVM200: When changing the operating mode (hand-arm, whole body, vibration); the x, y, and z
weightings and the k-factors update to match the defaults for the selected operating mode.

Spartan: Multi-line notes on the Summary page now show more that the first line of the note
(11450).

Spartan: When General Info is modified either in the data view or the report view, the
information is now shared in both places.

Spartan: The sensitivity will not get sent to meters when using the Push Settings feature.
Wind Speed was always reported using English units on Time History worksheet when the meter
was configured for Weather-INT. G4 now reports the units configured in the Weather-INT
settings.

Spartan Ul: The battery percentage is now correctly reported in the Live View tab - Meter
Overview.

A bug causing G4 to not show valid sound records for some data files has been fixed.

When there are more than 5000 time history records in an Event History the records greater
than 5000 now have a record number (11346).

Using G4 to load a settings file to the SoundAdvisor 831C that contains invalid settings could
result in the meter no longer being able to store calibrator settings. G4 now validates settings
before transmitting them to the SoundAdvisor 831C (11512).

In AudCal mode the Calibration Tab would switch to match the Live View when a test is run.
Fixed the arrow above the OBA and SLM overload indicators where it would display one or the
other but not both.

The Add Logo button now works for Spartan reports.

AudCal: Corrected "Set OSHA Levels" in Hearing Level. Changed level to 70 per OSHA standard
(11447).

AudCal: Fixed issue with the environmental adjustments for the AMC493 mastoid where the
adjustments were being added instead of subtracted.

Updated the Full FFT Live graph to correctly handle CPM with harmonics and Show Max.
831C-FFT: When setting custom units with other transducer, the meter would show wrong
display units on the calibration settings page.

FFT Chart: Fixed FFT chart so that Y-axis scales properly when switching between Linear/Log,
selecting units, and selecting items to display from tree. (11663)

HVM200: When entering notes in General Info the additional notes are now appended to notes
already in the file rather than overwriting existing notes.

HVM200: When an HVM200 file is deleted from the local PC the associated .meta file is also now
deleted. (11856)
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42. HVM200: When using G4 to delete HYM200 files, sometimes the cursor would change from the
spinner prior to the delete operation actually completing and the file list updating. The spinner
cursor now always remains active until the file delete operation and display update has
completed.

43. Command-Line Process: When processing multiple files, a defect resulting in some files failing to
export is fixed.

44. 831C: When the meter is configured for a weather sensor and there is no weather sensor
connected or a connected weather sensor is not sending data, invalid data "---" or -99.9 is now
reported for Wind and Gust Speed. Previously, negative values could be reported.

45. The file name and user info entry fields are merged on the Summary worksheet to use 6
columns so that the reports do not shift to multiple pages.

46. When clicking a sound recording from within the Session Log the sound recording now correctly
plays. Previously the sound recording wouldn't play until after clicking away from Session Log
entry.

47. 831A, LxT: The file data view for the Calibration Deviation in the summary and the Calibration
Changed entry in the session log would show incorrectly.

Known Issues
48. If G4 is running with active meter connections (meters showing on the tab display) when
Windows is locked, the meters on the tab display will become unresponsive.
a. Workaround — close and reopen the tab

G4 LD Utility Version 4.6.3 September 2021

1. Fixed issue with HYM200 files not opening.
2. Updated SoundAdvisor Model 831C firmware.

G4 LD Utility Version 4.6.2 May 2021

1. Support for LNE, French national, pattern approval.

2. Improved: When viewing the list of files in G4 LD Utility or Atlas the file list will appear faster.

3. Feature: Sort feature which allows data in SLM and FFT tabular data view to be sorted by right-
clicking the desired column and selecting 'Sort Descending' or 'Sort Ascending'. The data on the
following SLM and FFT tabs can be sorted: Statistics, Event History, Measurement History, Time
History, FFT Overall, FFT Measurement History (Avg), and FFT Measurement History (Max).

4. Feature: It is now possible to select whether a meter is defined by the meter serial number or
the IP address using the new "Connection Use" feature when defining a new connection. When
a meter is defined by the IP Address it is possible to define the meter name in G4 using a site
name. This provides the ability to swap meters at the site while keeping data from different
meters associated with the single site

5. Added: GPS information can be clicked to open a webpage showing the location on a map.
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6. Improved: When taking FFT measurements with an 831C and the Frequency Span divided by the
Number of Lines (bin resolution) is less than 0.4, the frequency information displayed switches
to two points of precision.

7. Improved: When importing Archive folders the files are correctly assigned the model and serial
number and are placed in the correct folder under the Meters folder instead of the Imported
folder. Further, when selecting the Export xIxs, json or csv in the Tools>Options these files will
also be created.

8. Fixed: While Pinning the LAF was incorrectly placed between the LASmin and LAFmin. It now
resides after the LAS.

9. Fixed: File Save As works for FFT files.

10. Fixed: On a Spartan file in French, the Audio will pass correctly to the Time History Graph.

11. Fixed: The Audio Streaming could be affected by network lag and close the stream with an error
message.

12. Fixed: When the Grouping option is selected, Edit Bands will correctly recalculate the data on
the Summary tab.

13. Fixed: The command-line file export will correctly process Model 831 archive files with sound
records. The command-line export will correctly handle network file/folder locations.

14. Fixed: The Import from USB/Open Archive Folder will correctly process files with sound records.

15. Fixed: When viewing a Spartan 730 file User, Job Description, Location and Notes would not
transfer between the tabular data view and the report.

16. Fixed: The User, Job Description, Location and Notes fields were not aligned with the labels in
the FFT files.

17. Fixed for 831: A defect that caused some files containing reverberation time or RT60 data to fail
opening in G4 has been fixed.

18. Fixed: In an 831C FFT file, the tonality graph view displayed the incorrect number of FFTs in
Average in the legend when selecting a measurement other than the first.

19. Improved: When configuring the 831C Time History with a period less than one second, the TMS
metric is now automatically enabled.

20. Fixed for 831C: The full screen FFT Live Graph axis units were reported incorrectly when
Integration was used. When set to use the logarithmic y-axis, if the min value is set to 0 the
graph will display correctly.

21. Fixed for 831C: The units on the metric in the file list for SLM files showed incorrect values when
"Other" transducer had previously been selected. The FFT metric in the file list will be displayed
with correct units once the file has been downloaded and opened.

G4 LD Utility Version 4.6.1 March 2021

1. Fixed: A defect that causes the time history graph in G4 to display incorrect data if Group
Metrics is selected on the Miscellaneous tab in Options has been fixed.

2. Fixed: When Group Metrics is selected then the Time History worksheet OBA data column

names were incorrect. The names have been moved to their correct columns and have been
updated to "SPL", "Leq", "Lmax" and "Lmin", for both the Full Octave and Third Octave data.
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G4 LD Utility Version 4.6.0 March 2021

1.

ok wnN

10.

11.
12.

13.

14.

15.

16.

17.

18.

19.

20.
21.

22.

23.
24,
25.
26.
27.

28.

Feature: FFT Support on the 831C.

HVM100 will no longer be supported by G4 after this release.

Feature: Export to CSV from File menu, command line or during auto download

Feature: Auto Download can be enabled and disabled from the Meter List context menu.
Feature: HYM200 displays live OBA graph at a rate of once per second for each of the 3 axes.
Feature HYM200: You can format the user storage Micro SD card in the Meter View ->
Maintenance tab.

Feature: For 831C, 831 and LxT meters, added new menu items to run, stop, store and reset
with the representation of the state of the meter.

Feature: Users can open files from their email, like double clicking in outlook.

Feature: If more than one user is talking to an 831-INT-ET G4 allows it to upgrade. During the
upgrade the other communication is ceased, until the upgrade is complete.

Feature: Addition of Auto Download to HYM200 which also updated the Meter View for the
HVM200.

Improved: When deleting files you may choose to delete the .xlsx, .csv and .json files.
Improved AudCal: Certificates, for Booth and Audiometers, show failed if the current Test Suite
has not passed.

Bug Fix: Allow older firmware to open the Meter View and allow the upgrade process for old
firmware for 831-INT-ET and Model 831

Improved: When a user changes the name of a meter in the meter list, the name is now used in
the Setup Manager and Auto Download sections.

Improved AudCal: You can create a mastoid without first creating a microphone and coupler.
Updated Spartan: Removed Virtual Dosimeter Detector setting, force to Slow

Fixed: In the Setup Manager on the meter side, sometimes did not show the Active setup after
transferring to meter.

Improved HVM200: Notify user that the entered sensor information will not be used if the
sensor has TEDS.

Improved Security: When changing the user password you cannot leave the Confirm Password
field blank. Pressing "Esc" does not break the password dialog.

Updated: When projects are removed, a popup asks if the user wishes to delete the files as well.
Fixed: On the SoundAdvisor 831C meter Ul, the Measurement History tab shows the correct
information after switching from a file

Fixed: When importing a settings file, the form fields (Threshold/Exposure) did not update if the
virtual Dosimeter modes changed.

Improved: G4 will restart upon switching languages to load the new language.

Improved: Ul Instructs the user to enter mV/m/s? for the sensitivity on HYM200 sensor.

Fixed: "Save All" button in Audio Player properly saves files for SLM and Spartan meters.

Fixed: In the FFT graphs, fixed issues with Tonality configuration input text boxes.

Improved: In command-line processing mode, if no output file name is specified, the input file's
name will be used for the output files.

Fixed: If no weather station was detected by the meter, G4 will correctly display the columns
affected.
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30.
31.
32.

33.
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Fixed: G4 could crash when auto downloads are enabled and G4 is closed while processing the
downloaded files from a meter.
Fixed: PTB files will open with this version of G4.
Fixed: (TT 7256) The status will display the correct USB voltage.
Fixed: If there is no motion for an entire measurement, the graph will display the "no motion"
line, if it exceeds the limit set in G4 Options.
Fixed: If first time history entry is invalid (like TWA) then the graphs still shows for the history for
the rest of the valid data.

G4 LD Utility Version 4.5.2 October 2020

1.

Feature: Addition of Rain and Hail weather data to the Time History spreadsheet for
SoundAdvisor Model 831C files.

2. Feature: You may now choose to keep similar metrics in the Time History together and to pin
the columns so that the data in the columns do not move based on selected metrics in the Time
History.

3. Improved: Updated connection functions to allow communication with older firmware.

4. Improved: Updated the firmware upgrade process to work with older firmware and slower
connections.

5. Improved: The meter model name for an LxT SE matches in the Meter List view.

6. Bug Fix: (tfs10244) Checkboxes show on projects and meters that are displayed when expanding
projects.

7. Bug Fix: AudCal Sync works with spaces in the file path for backups.

8. Bug Fix: Meters with Nicknames containing invalid characters are cleaned so that they show up
in the Meter List.

9. Bug Fix: Able to recognize old firmware on 831-INT-ET allowing user to select the upgrade 831-
INT-ET firmware from the context menu.

10. Bug Fix: AudCal signatures are validated before storing and retrieval to ensure user can continue
to use the report and certificate options.

11. Bug Fix: Spartan live view values truncated to whole numbers when PC language set to a
language where a comma is used as the decimal separator.

12. Bug Fix: Changes made to the Calibrators on the Calibration Settings page will now update the
main Calibration page.

13. Bug Fix: Spartan Time History graph now shows the Motion and No-Motion bands when viewing
files with 60 second histories.

14. Bug Fix: Reduced the time it takes to open sound level meter files with Time History by 7%.

G4 LD Utility Version 4.5.1 August 2020
1. Feature: Project folders may be sorted and moved. Pressing "Shift" while dragging a project will
allow you to drop the project inside another project. You may add Projects to other Projects.

2. Improvement: When a project or meter is renamed, the search feature will now update existing

files so they are found under the new name. For example, if | have a project named "Test" that

3425 Walden Avenue, Depew, NY 14043, USA +1 716 926 8243 © Copyright 2014-2022 Page 19



G4 LD Utility Release History

©LARSON DAVIS

A PCB DIVISION

contains 3 files and then rename the project as "NewTest" and then search for files in the
project "NewTest" it will find the 3 files that were previously in the project "Test”.

3. Bug Fix: When playing a sound record from a Spartan file, "Save All" will allow you to save all of
the Sound Records from that file.

4. Bug Fix: We have fixed G4 so that DNA can again connect to meters.

5. Bug Fix: Setup Manager configuration list will scroll with arrow keys.

6. Bug Fix: AudCal reports and certificates generation has been fixed. Also the pdf's support
different language fonts.

7. Bug Fix: In Setup Manager on an HVYM200 if you navigate through the time page after making
changes the meter did not let you cancel. The cancel works correctly with this release.

8. Bug Fix: An issue where an 831C spreadsheet did not save the User, Job Description Location or
Notes has been fixed.

9. Bug Fix: Auto-download and downloads would create a file with 20 Bytes even if the file no
longer existed on the meter, failed to download or communication was lost.

10. Bug Fix: Push Settings to multiple meters did not push Event Trigger settings to the meters. Now
all of the settings are pushed to each selected meter.

11. Bug Fix: Auto-downloads for Spartans did not always recognize new files unless the meter tab
was opened in G4. G4 now finds new files generated on the meter and auto-downloads them if
configured to do so.

G4 LD Utility Version 4.5.0 May 2020

1. Feature: Scheduling and Accounts have been added to the 831C. G4 allows you to interact with
these features.

2. Feature: G4 can communicate over a secure connection with the 831C.

Feature: G4 can now Auto-Download files from all SLM meters

4. Feature: Improved Dropbox authorization to use the Larson Davis G4 Dropbox and uses a folder
specific to G4. Included update uses localization of the interface.

5. Feature: The File Manager for all SLMs has been improved to allow searching of files based on
name, serial number, and general info. Further, Projects and Meters may be opened to browse
and search all files associated with these. Clicking on the item in the device panel will open this
new view.

The file list now has more columns that provide specific information about the file which can be
sorted. The list also loads faster from and is more responsive. When files are deleted from local
the xlsx is also removed. Right-click in file list allows you to open the file location in the windows
explorer. With Open on Download and Export to .xIsx checkboxes to help organize your data
when downloading.

The file manager allows for downloads to be cancelled and resumed

6. Feature: Projects now contain the folders of the meters that it contains and thus the files
downloaded from a meter in the project will also be stored in that project's sub folder. When
renaming projects G4 will try to move the files to follow the new project name.
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14.

15.
16.

17.

18.
19.
20.
21.
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Feature: More spreadsheets, graphs and data has been localized into more languages and
current languages have been expanded.
Feature: You may now upgrade multiple 831C meters simultaneously
Feature: New general help page for new and updated features
Feature: Ability to push Measurement and System settings to multiple meters simultaneously
Feature: Settings have been separated based on meter. Previously all of the settings resided in
the same location and thus a Default settings for 831C, 831, LxT and LxT SE were all the same
even though each meter had some minor differences. Now the Default settings will be specific
to each meter.
Feature: You may specify your "Default Path" for storing files for all meter types. Further,
Downloaded and Imported files are now saved to a folder structure that mirrors the assignment

of meters to Projects in the left pane of G4. Files will be stored as follows:

File path for meters in the Meters section of the G4 left pane:

DefaultPath\ \MeterName\model_serialNumber-startTime-meterFileName.extension
File path for meters under a Project of the G4 left pane:

o0 T o

DefaultPath \ \ProjectName\MeterName\ model_serialNumber-startTime-
meterFileName.extension

2. User may set project and meter names

File names are generated automatically, not user settable

4.  DefaultPath — Documents\PCB Piezotronics\G4 or as configured by user in G4 Options, File
Options

w

e. Storing the files this way permits fast and flexible file searching and better tracking
whether files have been previously downloaded, so they won't be downloaded again
every time they are opened.

Feature: The "Download Options, Download to Subfolder" checkbox has been removed. The "G4
Options, File Options" tab provides for setting the default location for downloading files. To
support new features, such as File Search, the organization of the files at the user specified
default path should not be modified or customized.

Feature: Spartan Files improved the Pre and Post Calibration information to include the
Deviation and Calibration Level. Also added Overload Count and Duration to the files.

Feature: Update Help Menu to separate the Release History from the Manuals

Feature: For the 831C, improved the order of the data included in the spreadsheet for Event
History and Event Time History with the new weather and all the weighted level data.

Feature: Edit Band modification time stamp arrows move the time faster the longer they are
depressed, allowing for faster navigation when using edit bands.

Feature: Removed HVM Licensing; no license is required for accessing the data from HVMs
Feature: Updated AudCal audiometer frequency selection to be based on transducer type

Bug Fix: Audio Streaming no longer has audio pop at the beginning of the stream

Bug Fix: Accidental Drag and Drop in the device panel has been fixed when trying to just select a
meter
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23.

24,

25.

26.
27.

28.

29.

30.

31.
32.

33.

34,

35.

36.

37.

38.
39.
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Bug Fix: Edit Band calculations were not always recalculated if only offset changed. Allow edit
band edge to start at the beginning of the file.
Bug Fix: G4 can now translate HYM200 and Spartan files with more than 1 million Time History
records
Bug Fix: If a file does not translate, and the error given "Array dimensions exceeded ..." or
"Arithmetic error", G4 will translate as much of the file as possible.
Bug Fix: Removing a project could cause other projects from not allowing meters to be moved to
them. You may now move meters to the new folders.
Bug Fix: AudCal the auto sync would turn on by closing the popup regardless of choice
Bug Fix: AudCal after upgrade of 831C and G4 did not always sync the AudCal database
afterward, now you can sync the databases correctly
Bug Fix: G4 will correctly translate files that have been downloaded using other software that
names the files as simdl files. Tonality is calculated correctly for FFT files named with simdl.
Bug Fix: Translation of SLM files continues even if audio may be missing from the file because of
meter being disconnected before file is fully downloaded
Bug Fix: With certain settings where TMS and OBA are logged in Time History, the translation
and/or graph would not complete
Bug Fix: Spartan files got saved with every zoom; now only saves upon request
Bug Fix: Spartan Report did not show ISO mode data. Also the spreadsheet labelled a line as
"LCpeak" but the weighting should be on a per virtual dosimeter basis was fixed.
Bug Fix: Opening a meter before G4 had gotten status would mean that the HLD version was not
known, so Setup Manager would not work
Bug Fix: Command Line Export uses correct numbering for audio files. Also allows for archives
files when input specifies only a folder containing multiple archive folders.
Bug Fix: Generated, temporary files are no longer stored next to a file that is opened. Ex. G4
would leave temporary files on the desktop if the file opened was on the desktop.
Bug Fix: Deleting HYM200 files that showed error when it should not have shown error
Bug Fix: For Spartan merged files stop record not showing with time history
Known: 831C SN: 10123 will not auto download.
Known Issue: If you experience issues with Spartan 730 meters not connecting over USB on
Windows 10 you may need to update the USB driver to work correctly.

G4 LD Utility Version 4.0.8 January 2020

Bug Fix: When using a graph to create an edit band, a bug that could cause the start and end
time of the edit band to be up to two samples different from the data used to compute the
change has been fixed. The start and end times shown on the graph now match the times used
to compute modified data exactly.

Bug Fix affecting 831C: A bug that can cause a meter to appear in the meter list multiple times
has been fixed and each meter now shows only once.

Improvement: If an error occurred on obtaining tonality information from an FFT file G4 did not
display any information. A message has been added.
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Improvement: When renaming a meter in the meter list by using the "rename meter" function,
the edit dialog is now shows the previous name for editing rather than "edit name”.
Improvement: The Command-line processing has improved logging, including any unrecognized
parameters.
Bug Fix affecting 831C: A bug that could cause the live display to have a gray overlay and then
not accept inputs has been fixed.
New Feature: When viewing the live data for a Spartan 730 noise dosimeter, a live Leq graph is
now available.
Bug Fix affecting 831 and 831C: When the time history sample period is greater than once per
second and events are automatically marked in the G4 graph it was possible for an event to
begin and end during a single time history sample, which resulted in the start and end times of
the exclusion band not being correctly set. This has been fixed so the start of the exclusion band
will be the time history sample including the start of the event and the end of the exclusion
band will be the sample containing the end of the event.

G4 LD Utility Version 4.0.7 December 2019

Bug Fix: Updated installer to properly add drivers to 32-bit machines.
Bug Fix: Closing the Calibration popup using the "x" would leave the meter in a locked state.

G4 LD Utility Version 4.0.6 November 2019

Feature: You can set the y-Axis extremes on the Time History SPL/LEQ graph.

Bug Fix: Sometimes the dates on the control would change to a wrong date after selecting the
desired date. This includes the fix for the Time Zone offset causing the day to appear to be the
previous day when in the Eastern Hemisphere.

Bug Fix: The Event Triggers would not appear on the Measurement Properties popup menu
when on the Setup Manager Tab.

Bug Fix: RClone would not authorize or would crash G4.

Bug Fix: AudCal failed to sync the meter's database with the G4 database.

Bug Fix: HVM license manager popup incorrectly when trying to use G4 with SLMs.

Bug Fix: AudCal could force the manufacturer to appear as Larson Davis.

Bug Fix: The Locked Screen with the Big Digit display would show the incorrect label.

Bug Fix: Opening a meter while Setup Manager is already in System Properties would cause a
looping reload cycle.

Bug Fix: HYM100 connection dialog now shows the serial connection panel.

Bug Fix: Missing Manuals from the Help menu.

G4 LD Utility Version 4.0.5.1 October 2019

Bug Fix: The SLM time history charts would not finish processing if the Weather-INT was enabled
in the file. The charts will finish and display.
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Bug Fix: Hyphens in the meter's address will now work correctly allowing G4 to access the meter
and display correctly in the device panel.
Bug Fix: Opening a file outside of the meter's folder will now allow you to email the report and
file.
Some third-party security software on your desktop could put tracking files into archive files
breaking the file structure for the SLM files. The files are now ignored by G4 when importing the
archives (.s folders).
Feature: Low Frequency L(20-200Hz) added to the 1/3 Octave section on the OBA tab in the
spreadsheet

G4 LD Utility Version 4.0.5 September 2019

Bug Fix: Spartan File Merge works again as it wouldn't run in the previous release

Bug Fix: Spartan files sometimes could contain bumps that would have multiple exclusion bands
created for them. G4 now creates the bands correctly and only allows a single band that is wide
enough to be selected.

Bug Fix: Edit bands now show the same information as the highlights in the Time History tab in
the spreadsheet

Feature: Feature: Setup Manager menu item added to the file menu so that setups can be
edited when there has never been a connection to a sound level meter

Feature: AudCal now allows users to use non Larson Davis artificial mastoids

Bug Fix: When opening the AudCal View from the File menu, G4 seemed to hang, now the view
opens correctly

Bug Fix: Setup Manager settings on 831A would not display

Bug Fix: The Save All sound records feature in the Session Log crashed G4

Bug Fix: Measurement History Alert configuration is now retained in the Settings

Bug Fix: An error that would occasionally occur when transferring properties from a PCto a
meter has now been fixed

G4 LD Utility Version 4.0.4 August 2019

Bug Fix: The authorization of the Push Feature using rClone would fail, crashing G4. The
authorization works correctly and G4 no longer crashes due to the issue with rClone.

G4 LD Utility Version 4.0.3 August 2019

Feature: Added configurable trigger source and level to Measurement History Interval email and
text alerts, updating the property Control tab to allow users to select these options

Feature: Added pause, run, and reset to list of conditions that will trigger state transition email
and text alerts

Bug Fix: Fixed issue where date filenames restart at sequence number 0 after reboot or when
files have been removed (i.e., moved to Dropbox). Now the sequence number will only reset to
0 at the beginning of a day
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Feature: Added 1, 2, and 5 minute Daily Auto Store periods and changed user interface to show
interval time rather than files per day.
Spartan 730 Dosimeter Update: In the Settings the grey color denoting inactive or unavailable
settings is now more noticeable. The Threshold Enabled is disabled in ISO mode.

Bug Fix: G4 would hang sometimes when switching between 831C and Spartan tabs

Bug Fix 831C: When there are more than 500 files on the meter, G4 will display the files in pages
with up to 500 files per page. Deleting all files on the last page no longer causes the Pagination
to disappear

G4 LD Utility Version 4.0.1 July 2019

Spartan 730 Dosimeter Feature: You have the option to set an administrator passcode that,
when set, allows users to access settings, system tools, or delete files, only after providing the
passcode. The passcode is enforced only when using a Bluetooth connection and not when
connected via USB.

Bug Fix: Previously, system properties may be corrupted when transferring between other
831Cs or G4 LD Utility software with different software or firmware versions. Now, differences
between versions are handled correctly. If concerned about possible corruption, use G4 LD
Utility V4.0.1 or later to resend system properties to the meter.

Bug Fix affecting 831 & 831C: Weather data displaying dashes when the value is 0.0 has been
fixed and 0.0 is correctly displayed.

Bug Fix affecting 831 & 831C: Wind compass direction would display as dashes if the direction is
between 350 and 359 degrees. Now, correct direction is shown for all cases except when
direction is due north (0 degrees), which still shows dashes.

Modification and Bug Fix: The menu item, located at File >> Save Edit Band Data has been
changed to Save SLM File. The menu item did not actually save the file, resulting in a prompt to
save when the file was closed.

Bug Fix: When authorizing the meter to use DropBox, G4 would lock up. This now works
correctly.

Bug Fix: Previously, the edit band shown in the G4 Time History tab (used for calculating the
modified data) was late by one time history sample. Edit bands are now shown correctly in the
tab.

Bug Fix: When upgrading firmware, the default folder for the firmware file remains consistent
and works as expected. (7400)

Bug Fix: When an SLM has more than 500 files, data files displayed in the Data Manager tab are
correctly sorted from newest to oldest according to the start time. You don't have to go to the
last tab in order to see the newest files.
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Improvement affecting Spartan 730 Dosimeter: The Live View navigation bar remains at the top
of the window when scrolling down, instead of scrolling off the top.

Bug Fix affecting Spartan 730 Dosimeter: Previously, edit bands created automatically due to a
"bump" created 2 exclusion bands for each bump. Now, each "bump" creates 1 "exclude" edit
band.

G4 LD Utility Version 4.0.0 June 2019

New connection device panel provides direct access to all meters with a single click

Support for the new Spartan 730 noise dosimeter

Support for Projects, the ability to organize meters into user created projects

Made upgrading meters easier by meter specific context menu from the device panel

Setup manager updated to reduce the loading time

Push settings to all connected Spartan meters

Improved communication with HYM200 and 831C meters to allow quicker connection

Improved the graphs for sound level meters, with the legend set to the bottom with values, edit
bands, and data corrections updated modified data, unused menu options removed, and only
open graph if valid time history exists

G4 no longer supports connections to meters via analog modems or serial connections, with
the exception of the serial connection for HYM100 meters

HVM100 connection panel updated and moved to Tools menu

Known Issue: The auto-merge for HYM100 has been disabled.

Bug Fix: Spreadsheet Measurement History records were highlighted red when no overloads
occurred

Bug Fix: Setup manager file list did not update after "format internal" (6407)

Bug Fix: 831C Setup manager didn't match the duration of the meter

Bug Fix: Cannot Play Voice Recordings is session log (7187)

Bug Fix: Gears did not go away after downloading a file with no Time History from 831A (7188)
Bug Fix: HYM100: HVM disconnects when run started if HVM is overloaded. G4 can crashes after
disconnect (7131)

Bug Fix: Sync PC and Meter Clocks on maintenance tab does not work with 831C (7010)

Bug Fix: On the meter the adjust graph is not available (grayed) when looking at the spectral Ln's
on the overall tab (5105)

G4 LD Utility Version 3.3.1 April 2019

Bug Fix: Fixed issue in SLM Measurement History spreadsheet where LNs values were not
displayed correctly.

AudCal: The variance in frequencies used during Distortion, Frequency, Hearing Level and
Narrow Band Noise tests tightened to make the auto switching not use the previous frequency;
this is usually seen with 1500 and 1600 Hz.
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AudCal: For Distortion, Frequency, Hearing Level, FM and Narrow Band Noise tests, we
increased the time for failure before moving to the next step.

G4 LD Utility Version 3.3.0 January 2019

Updates to support new PTB certification

Update to the command line feature to allow for archive files received from the 831C Automatic
Push to be processed to JSON/XML/XLSX

The settings for OBA and Sound range now show the range in dBA as well as the Normal and
High selection

Updated the graphs for 831C, 831 and LxT to work with older and broader range of systems,
specifically systems that support WebGL1 but not WebGL2.

Fixed Edit Bands edge adjusters for 831C, 831 and LxT graphs so that right edge arrows no
longer update left edge text

Updated firmware upgrade to reboot before starting the upgrade to improve the success of the
upgrade process. Also allow multiple meters to be upgraded at the same time.

Known Issue: In the Measurement History of the spreadsheet the first column may be marked in
red if an overload occurred in any of the histories. The column background red color may
disappear when scrolling in the spreadsheet.

Bug Fix: Correctly adjust for the expected frequency response curve from the data input from a
certificate of the AEC304 coupler

Bug Fix: G4 would fail to apply an Edit Band offset with non-numeric data (i.e. Gust Direction)
Bug Fix: The Stop When Stable Run Mode would not use the time that was entered in the
Control measurement properties

Fix for no sound Time History Records in data file so that graph is not displayed (6589)

Fixed the recalculation of the Summary to stop errors when no edit band is found

Saving files will check for a valid path before trying to save just in case the path has been
removed. If saving to removable media, each save will check for the media instead of failing to
save to the removed media.

Feature: Added logic to handle .s archives with names that are too long by asking the user
rename them so they may be processed

Bug Fix: Modified logic to allow users to import .s archives from the root of a drive or from the
second level of the file system

Bug Fix: crash when Exporting of HVM files to spreadsheet and printing HVM reports

When using G4 to graphically edit HVM data taken for a whole body measurement, the modified
summation values for the A(8) Act and A(8) Exp are now correctly computed

User can now store samples of the Running Leq in time history

If a setup configuration did not have the new trigger settings, Events would not trigger correctly.
The setup files are updated when they used in G4 or on the meter.

Changed AudCal narrow-band noise calculation to use FFT instead of octave bands. This allows
the 831C to correctly determine the narrow band noise levels when the noise bandwidth does
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not match 1/3 octave filter bandwidths. Added the level to the AudCal page on the meter and
augmented the data displayed on the test page to include the band edge frequencies.

AudCal now restricts the bone vibrator to a frequency range of 250Hz to 8kHz, supra-aural and
inserts are restricted to 125Hz to 8kHz and circum-aural and speakers range from 125Hz to
20KHz.

When closing files a single check is made for modifications and a dialog will ask if the file should
be saved. Improved the saving of files when changes are made.

Fixed AudCal to allow high frequencies in all tests. In Hearing Level and Narrow Band Noise tests
valid Hearing levels will need to be entered for the high frequencies.

Fix crash when Calibrating a Model 831A meter

Bug Fix: (TT 6901) G4 no longer crashes when using "Save All" on sound recordings in the file
view

Bug Fix: (6591) Change masked options without reboot and data not stored, then change a
property with Reset Required will cause the user interface to lockup

Bug Fix: (6517) Fix for Daily Timer Start Time 3 input so that it is not over written by End Time
Bug Fix: (6515) Graphing: The Data Legend Marker needs to display when clicking on graph

Bug Fix: (6594) 831C Ul: Auto store set to Prompt causes 2 prompts to be seen when stop is
pressed

Bug Fix: (6598) HVYM200 — Sometimes in Live View the settings page is invisible

AudcCal: Fix for the Certificate generation for Booth Tests when missing equipment

AudCal: Fixed Report generation of the Hearing Level test when using high frequencies

AudcCal: Fix for "Set Levels" for the Narrow Band Noise and the Hearing Level tests to allow non-
standard frequencies including high frequencies

AudCal: (6267) Fixed the FFT zoom when accessing the Live View in G4 or on a tablet

Bug Fix: (TT 6976) Fixed the selection of a Measurement or Event to be persistent when more
than one exists while accessing the Live View in G4 or on a tablet

G4 LD Utility Version 3.2.1 September 2018

Addition of the Time History graphs for LxT, Model 831 and SoundAdvisor
o Zoom and panning of the time history data
o Report generated for printing and in pdf form with overall summary and graphs
o OBA spectrograms align with the level line graphs
o Playback of audio denoted in the graphs including continuous audio
= The audio playback and the audio graph marker could be off by up to one
second, due to sound recording timestamp resolution.
o Events marked on the graph including the ability to playback associated audio records
o Editing of the time history using edit bands, with offsets and exclusions
When zoomed, the graphs may not line up completely.
Added the ability to set static IP address on 831C
Updated Event Triggers to work with new functions on the 831C
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Added Running Leq setting

The folders for saving are tracked for user

Audiometric Calibration reports improved and their generation sped up

AudCal right-click menu on the tree to allow adding and removing of items

Fix bug with the RETSPL's not storing for high frequencies

Update for non-meters appearing in the list of USB devices

Changing the language in G4 updates the meter directly

Updates to the Light and Dark themes to improve legibility

Connection table no longer looks for duplicate meters or combines names of duplicate meters
Added "Export to JSON/XML" functionality (also available from command line)

G4 LD Utility Version 3.10 April 2018

Audiometric Calibration (AudCal) functionality added to G4

The Ul has been improved for the Import Files from USB Drive

The Audio Streaming Ul is reset when streaming is stopped when changing tabs

Updates to the Meter Catalog that will back up the catalog and reduce the number of writes to
reduce the chance that catalog entries are lost

Fixed potential crash from bad or unstable TCPIP communication

Settings and Property files will transfer correctly between PC and Meter

When using Set to Active the meter sometimes loaded the wrong setup

Cal Check can be run from G4 and improved responsiveness to the Calibration pages, also
updates to the Certification Reminders were not working.

Time History OBA Overload column only in export if Time History OBA metrics were selected
Added command line parameters to process a .Idbin file or all .Idbin files in a folder to create
Xlsx files

Fix for dpi issue causing the Meter View to not display properly in some configurations
Added System Metrics for the 831C on the spreadsheet summary tab

Updates to audio playback and audio streaming, including potential crash bug fix

HLD on the meter was crashing when connecting from G4

Fixed issue with removing setup files where they would not always be removed

Improved the resolution of many of the icons in menus

Fixed weather page that had trouble with switching units between degrees and compass, and
missing Temperature

G4 LD Utility Version 3.06 November 2017

Firmware upgrade process to protect against downgrading to prior than 3.06 to prevent errors
reading/writing newer flash chips
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G4 LD Utility Version 3.05 October 2017

Fix for Model 831 and SoundAdvisor Time History TMS showing in the wrong column, and
weather data with correct units

Units on OBA are now correct when using integration with HYM200

Added Portuguese (BR) to G4 language selection menu.

Updated current languages with missing strings

Fixed crash when playing audio files in G4

Fixed ScreenGrabber so that a momentary loss of connection no longer stalls screen updates

G4 LD Utility Version 3.04 June 2017

Allow users to configure the SoundAdvisor Model 831C to use SFTP or Dropbox for cloud
storage. Files are transferred after they are stored on the 831C.

New "Open .s Folder" option, to allow users to open files from Dropbox or SFTP

Updated lock/unlock feature to ensure a code is entered for Model 831

Added more parameters like epoch time for audio file command line export also improved
documentation

Fixed meter connection issue where name on tab was incorrect. (5667)

Removal of temporary files on installation (5666)

Added HVM200 annotations in spreadsheet export. They are found in the Notes field and in a
column in the time history tied to the time at which they were entered. Updated the column
width for the summary.

Fixed the "Restore Defaults" function on the Tools->Options->File Options tab so that the
correct defaults are restored

Initial default for downloading files will open the file in G4 (5386)

Fixed the gust and wind direction column on Measurement History spreadsheet to display the
correct directions if units are set to compass, e.g., N, NE or S (5362)

Fixed issue where Live View would not update when meter would turn off backlight

G4 LD Utility Version 3.03 May 2017

Fixed Time History and Event Time History spreadsheet to properly display all values when a
comma decimal separator is used as part of the Culture Info

Updated Audio Streaming to work if a password exists on the Model 831A meter

Added capability to slide the Status display off to the right and back again

Improved the 831-INT-ET upgrade process to work with the Sound Advisor and remove the time
constraint when trying to connect

For time history periods greater than 1s previously the meter would report the wind speed and
direction for the last 1 second sample. Now the meter reports the average over the sample
period.

Fixed issue with Event Time History so that the post trigger is now displayed correctly
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Added command line operation of G4 to export audio files directly from LDbin files with the use
of the SDK
Added support for NMS044 with a new setup file that will appear at the top of PC list
Installation will notify you when Administrative privileges are needed and cause installed files to
be accessible with any standard user
Fixed crash bug with older versions of 831-INT-ET firmware
When using WiFi in G4, the password is now correctly saved, allowing connection over WiFi
Added the Time Zone property to the Set Time dialog from the Meter Manager Maintenance tab

G4 LD Utility Version 3.02 April 2017

Release in conjunction with new firmware for 831C
Improvement of the HYM200 firmware upgrade process

G4 LD Utility Version 3.00 March 2017

Provide connection and tools to work with SoundAdvisor™ Model 831C (831C)
Improved Setup Manager to work better with all meters

Update Audio Streaming to also include Compression on 831C

Improved connection status with meters

Fixed issue with file translation and GPS data with no sync, and Measurement Histories.
Further improvements to the Spreadsheet Views

Updated connection dialog

Improved time sync with meters

Improved messaging when G4 is minimized or not visible

Fixed a few issues related to culture variants

Audio Playback in Live View for 831C

Upgrade process for 831C

Allows meters to display language of G4 not the meter.

Fix for Store command

File Listing in Meter Data View shows data completely and display USB icons for files on 831C
Improved audio normalization

Fixed issues for Calibration Histories for LxT1 and other meters.

Minor Ul fixes to Live View

G4 sizing is now stored between sessions

Drag and drop files onto G4 to open

Fixed Time History display of LAeq to show more decimals of precision (4438)

G4 LD Utility Version 2.2.1 December 2016

Fixed the password issue that blocked transferring of setup files
Fixed issue with playback of Sound Records
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G4 LD Utility Version 2.2.0 November 2016

New Light Theme available from the Option Miscellaneous tab

Fix for FFT tonality crash when graphing tones

Improved download reliability, especially on bad connections
Connections dialog modified to ensure multiple connections to same meter cannot occur
Fixed sImdl import, multi-record import, cal/cal check history graph

LxT preamp displays correct preamp data

Improved Configuration Manager and associated loading

Added ability to download to subfolders

Changed status page time to display 24 hour clock

Fixed issue with file translations especially in different locales

Move Time History "TMS" column immediately after the "Time" column
Fixed mislabeled field in Summary spreadsheet tab

Improved the playback of sound records in spreadsheet with placement in Measurement
records and Event History records including scrolled content.

Window size of G4 remembered between launches

Full time zoom for HYM200 in Live View

Improved the spreadsheet translation process

Improved Ul experience, removing lag in certain operations

Improved communication with HLD including shutdown

Update to allow Settings in HYM200 on live view in G4

Fix for event history page elements size issue

G4 LD Utility Version 2.1.0 August 2016

Improved playback of voice and sound records (Audio Scaling)

Improved file processing with messages, also fixes for .sImdl files (6456, 6535, 6561)

Further improvements to printed reports for HYM200 and HVM100 (2803, 3292, 6557)
Improved Messaging, Meter Interaction and File Indicators

Fixed G4 Maintenance Tab / Set date and time dialog for HYM200

When transferring Property files a name may be specified

Fix for opening LxT and 831 files from USB, allowing G4 to "Import" USB data files in a more user
friendly way. Can select files from multiple folders, no extension requirement, and better error
messages (6544)

Added Measurements and Metrics (M&Ms) to the SLM spreadsheet

Improved Meter Connection Dialog with filter for TCP and constant updates of meters plugged
in via USB

Improved firmware and option uploader

Spanish and Russian initial localizations

Data file working indicator
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Removed crash bug — Cal Histories

G4 LD Utility Version 2.0.3 June 2016

Removed 2 crash bugs

G4 LD Utility Version 2.0.1 March 2016

Improved playback of voice and sound records including the user interface (6408)
Print report for HYM200 and HVYM100 improved (6475)

Fixed zoom on LiveView (6388)

Fixed issue where left-mouse button zoom hits an invisible wall (6494)
Fixed Excel export process (6493)

GPS correctly displayed (6300)

Warn user about potential device data format when upgrading (6399)
Fixed fresh install issue for xlsx

Fixed Summary "Sensitivity" formatting

Fixed some minor issues with settings for HYM100 and 831a
Improved file download

Fixed a potential crash on international installations

G4 LD Utility Version 2.0.0 December 2015

Added support for HYM200 and HYM100

New graphing for Time History and OBA Heat Maps for HVM
Improved connection dialog

Single tab for System and Measurement Properties

USB 3.0 support

Improved File translations

Updated the 831-INT-ET firmware to improve communications
Fixed some minor errors with downloading from 831-INT-ET
Improved Serial communications

Fixed issues with Proxy Servers

Removed support for Windows ® XP

SLM Utility-G4 Version 1.1.1

Import for LxT_Data files support

Fixed some minor errors in File Translation under Measurement History, and Time History
Spelling errors in the file translation process

Fixed a crash bug due to slow disconnect when closing down a connection

SLM Utility-G4 Version 1.1.0 January 2015

LxT Support
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o Improved spreadsheet load time
e Added 64-bit version to allow for larger Idbin file sizes
e Updated Calibration History tab
e Improved Audio Streaming tab, including Dynamic Range Compression
e Added Reference Spectra
e Improved file downloading/opening and messaging
e Double-click on Idbin file to open in G4
e For the Main Top tabs: More contrast between background of active and inactive tab and bold
the title of active tab
e Added Normalization for playback of session log audio recordings

SLM Utility-G4 Version 1.0
e First Release
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